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• What is Microsoft Word 2021 | माइक्रोसॉफ्ट वर्ड  2021 क्या है? 

• How to Open Microsoft Word 2021 on Computer | माइक्रोसॉफ्ट वर्ड 2021 को कंप्यूटर पर कैसे खोलें? 

• Main Components of Microsoft Word 2021 Application | माइक्रोसॉफ्ट वर्ड 2021 एप्लीकेशन के मुख्य अवयव 

• Microsoft Word 2021 Tabs and Options | Microsoft Word 2021 के टैब्स और ऑप्शन्स 

• 1. File Tab 
• 2. Home Tab 

• 2.1 Clipboard Manager 
• 2.2 Font 
• 2.3 Paragraph 
• 2.4 Styles 
• 2.5 Editing 
• 2.6 Add-ins 

• 3. Insert Tab 
• 3.1 Pages 
• 3.2 Tables 
• 3.3 Illustrations 
• Object Controlling Options in Format Tab 
• 3.4 Media 
• 3.5 Links 
• 3.6 Comments 
• 3.7 Header and Footer 
• 3.8 Text 
• 3.9 Symbols 
• 4. Draw Tab 
• 5. Design Tab 
• 6. Layout Tab 

• 6.1 Page Setup 
• 6.2 Paragraph 
• 6.3 Arrange 

• 7. Reference Tab 
• 7.1 Table of Contents 
• 7.2 Footnotes 
• 7.3 Citations & Bibliography 

• 8. Mailings Tab 
• 8.1 Create 
• 8.2 Start Mail Merge 
• 8.3 Write and Insert Fields 
• 8.4 Preview Results 
• 8.5 Finish & Merge 

• 9. Review Tab 
• 9.1 Proofing 
• 9.2 Speech 
• 9.3 Language 
• 9.4 Comments 
• 9.5 Tracking 
• 9.6 Compare Document 
• 9.7 Protect 

• 10. View Tab 
• 10.1 Document Layouts 
• 10.2 Immersive 
• 10.3 Show/Hide 
• 10.4 Zoom 
• 10.5 Window 
• 10.6 Macros 

• 11. Help Tab 
• Help & Support 
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माइक्रोसॉफ्ट क्या है? 

माइक्रोसॉफ्ट दनुिया में कंप्यूटर सॉफ्टवेयर का सबसे बडा ववके्रता है। यह क्लाउड कंप्यूटटगं सेवाओं, वीडडयो गेम, 

कंप्यूटर और गेममगं हाडडवेयर, खोज और अन्य ऑिलाइि सेवाओं का अग्रणी प्रदाता भी है। माइक्रोसॉफ्ट का 
कॉर्पोरेट मुख्यालय रेडमंड, वाम गंटि में स्थित है, और इसके 60 से अधिक दे ों में कायाडलय हैं। 

Microsoft Office Version & Year 
Release date Title Components 
October 1, 1990[1] The Microsoft 

Office for 
Windows 

Word 1.1, Excel 2.0, PowerPoint 2.0[2] 

March 4, 1991[3] Office 1.5 Word 1.1, Excel 3.0, PowerPoint 2.0 
July 8, 1991[4] Office 1.6 Word 1.1, Excel 3.0, PowerPoint 2.0, Mail 2.1 
Early 1992 Office 2.5 Word 2.0a, Excel 4.0, PowerPoint 2.0e, Mail 2.1 
August 30, 1992 Office 3.0 Word 2.0c, Excel 4.0, PowerPoint 3.0, Mail 3.0 
January 17, 1994 Office 4.0 Word 6.0, Excel 4.0, PowerPoint 3.0, Mail 3.1 
June 2, 1994 Office 4.3 Word 6.0, Excel 5.0, PowerPoint 4.0, Mail 3.2, Access 2.0 
July 3, 1994 Office for NT 4.2 Word 6.0, Excel 5.0, PowerPoint 4.0, Office Manager 
August 24, 1995 Office 95 (7.0) Word, Excel, PowerPoint, Schedule+, Binder, Access, Bookshelf 
November 19, 
1996 

Office 97 (8.0) Word 97, Word 98, Excel, PowerPoint, Access, Publisher 97, 
Publisher 98, Outlook 97, Outlook 98, BookShelf Basics, Small 
Business Financial Manager 97, Small Business Financial 
Manager 98, Automap Street Plus, Direct Mail Manager, Expedia 
Streets 98 

June 20, 1997 Office 97 
Powered by Word 
98 (8.5) 

June 7, 1999 Office 2000 (9.0) Word, Excel, Outlook, PowerPoint, Access, Publisher, Small 
Business Tools, FrontPage, PhotoDraw 

May 31, 2001 Office XP (10.0) Word, Excel, Outlook, PowerPoint, Access, FrontPage, Publisher, 
Small Business Tools 

August 19, 2003 Office 2003 (11.0) Word, Excel, Outlook, PowerPoint, Access, Publisher, OneNote, 
InfoPath 

January 30, 2007 Office 2007 (12.0) Word, Excel, PowerPoint, Outlook, Publisher, Access, Groove, 
OneNote, InfoPath, Communicator, Visio Viewer, OCT 

June 15, 2010[8] Office 2010 (14.0) Word, Excel, PowerPoint, OneNote, Outlook, Publisher, Access, 
InfoPath, SharePoint Workspace, Visio Viewer, OCT, Lync 

January 29, 2013 Office 2013 (15.0) Word, Excel, PowerPoint, OneNote, Outlook, Publisher, Access, 
Lync, Skype for Business, Visio Viewer 

September 22, 
2015 

Office 2016 (16.0) Word, Excel, PowerPoint, OneNote, Outlook, Publisher, Access, 
Skype for Business, Visio Viewer 

September 24, 
2018 

Office 2019 (16.0) Word, Excel, PowerPoint, OneNote, Outlook, Publisher, Access, 
Skype for Business, Visio Viewer 

October 5, 2021 Office 2021 (16.0) Word, Excel, PowerPoint, OneNote, Outlook, Publisher, Access, 
Skype for Business, Visio Viewer 

October 1, 2024 Office 2024 
(16.0) 

Word, Excel, PowerPoint, OneNote, Outlook, Access, Skype for 
Business, Visio Viewer 

 

What is Microsoft Word 2021 | माइक्रोसॉफ्ट वर्ड  2021 क्या है? 
Microsoft Word 2021 पूरी दुनिया मे इसे्तमाल निया जािे वाला सबसे लोिनिय वर्ड िोसेनसिंग ििं पू्यटर सॉफ्टवेयर है। इसे 

माइक्रोसॉफ्ट िापोरेशि द्वारा नविनसत निया गया है। इसिा इसे्तमाल बैंिोिं व सभी िायाडलयोिं मे निम्न सिंबिंधी िायड िरिे िे नलए निया 

जाता है। 

इस एप्लीिेशि िा इसे्तमाल िरिे निए जािे वाले िायड – 

• Business Letters & Agendas 
• Bio-Data & CV 
• Magazines & E-Books 
• Invitation Cards 
• Business Reports 
• PDF Files 

https://en.wikipedia.org/wiki/History_of_Microsoft_Office#cite_note-1
https://en.wikipedia.org/wiki/History_of_Microsoft_Office#cite_note-2
https://en.wikipedia.org/wiki/History_of_Microsoft_Office#cite_note-3
https://en.wikipedia.org/wiki/History_of_Microsoft_Office#cite_note-4
https://en.wikipedia.org/wiki/Microsoft_Office_3.0
https://en.wikipedia.org/wiki/Microsoft_Office_95
https://en.wikipedia.org/wiki/Microsoft_Office_97
https://en.wikipedia.org/wiki/Microsoft_Office_2000
https://en.wikipedia.org/wiki/Microsoft_Office_XP
https://en.wikipedia.org/wiki/Microsoft_Office_2003
https://en.wikipedia.org/wiki/Microsoft_Office_2007
https://en.wikipedia.org/wiki/History_of_Microsoft_Office#cite_note-8
https://en.wikipedia.org/wiki/Microsoft_Office_2010
https://en.wikipedia.org/wiki/Microsoft_Office_2013
https://en.wikipedia.org/wiki/Microsoft_Office_2016
https://en.wikipedia.org/wiki/Microsoft_Office_2019
https://en.wikipedia.org/wiki/Microsoft_Office_2021
https://en.wikipedia.org/wiki/Office_2024
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• Labels & Stickers 
• Application Forms 
• Brochure & Invoices 
• Question Papers, etc. 

िोट : Microsoft Word िी फाइल िा Extension Name *.docx होता है। 

How to Open Microsoft Word 2021 on Computer | माइक्रोसॉफ्ट वर्ड 2021 को कंपू्यटर पर कैसे खोलें? 
माइक्रोसॉफ्ट वर्ड िो ििं पू्यटर पर खोलिे िे निम्न तरीिे हैं- 

1. Click on Start Menu>All Programs>Microsoft Office>Microsoft Word 2021 
2. Click on Start Menu>Run>winword 
3. Right Click on Desktop>New>Microsoft Office Word Document 

उपरोक्त मे से निसी भी मेथर् िा उपयोग िरिे Microsoft Word स्टाटड िर सिते हैं। 

िोट – अगर यह सॉफ्टवेयर आपिे ििं पु्यटर पर इिंस्टॉल िही िं है, तो उपरोक्त मेथर् िायड िही िं िरें गे। 

Main Components of Microsoft Word 2021 Application | माइक्रोसॉफ्ट वर्ड  2021 एप्लीकेशन के मुख्य अवयव 

Microsoft Word 2021 Application Window with Component Names 

माइक्रोसॉफ्ट वर्ड अप्लीिेशि िे नवनभन्न िम्पोिन्ट निम्ननलखखत हैं। 

• Title Bar – यह बार सबसे ऊपर िदनशडत होती है, इसमे File Name, Search Bar, Account Sign in िे साथ एप्लीिेशि नविंर्ो 

िो बिंद, ररस्टोर तथा नमिमाइज़ िरिे िे ऑप्शि उपलब्ध होते हैं। 

• Tabs – टाइटल बार िे ठीि िीचे िा के्षत्र है जहािं नर्फॉल्ट रूप से 11 टैब िदनशडत होते है; File, Home, Insert, Draw, 

Design, Layout, Reference, Mailing, Review, View और Help. इि टैब्स में र्ाकू्यमेंट क्रीऐट व मैिेज िरिे िे नलए नवनभन्न 

नविल्प मौजूद होते हैं। 

• Ribbon – टैब िे िीचे िा के्षत्र जो एि पट्टी िे रूप मे िदनशडत होता है। इसमें चयनित टैब से सिंबिंनधत टूल्स िदनशडत होते है। 

यह सभी टूल्स िायड िे अिुसार गु्रप मे व्यवखथथत होते हैं। CTRL + F1 दबािर ररबि िो हाइर्/अिहाइर् निया जा सिता है। 

• Quick Access Toolbar – यह टूलबार Ribbon िे ऊपर िदनशडत होती है। इस टूलबार मे ऐसे नविल्प उपलब्ध होते है 

नजििा इसे्तमाल बार-बार निया जाता है; जैसे – Save, Undo, Redo आनद। इस टूलबार िे नविल्पोिं िो यूजर िे अिुसार 

िास्टमाइज़ भी निया जा सिता है। 

• Ruler – यह एि से्कल िी तरह नदखता है, जो र्ाकू्यमेंट पेज िे ठीि ऊपर व बाएिं  िदनशडत होता है। यह पेज िी मानजडि सेट 

िरिे में मदद िरता है। 

• Page Area – यह मुख्य एररया होता है, जहािं हम र्ॉकू्यमेंट िी जाििाररयोिं िो नलखते हैं। 

• Scroll Bars – स्क्रॉलबार पेज िे नििारोिं पर िदनशडत होती हैं। इििा उपयोग पेज िो ऊपर-िीचे, दायें-बाएिं  स्क्रॉल िरिे िे 

नलए निया जाता है। 

• Status Bar – यह बार वतडमाि र्ाकू्यमेंट िी जरूरी जाििाररयोिं िो नदखाती है, जैसे – िुल पेज, िुल शब्द आनद। 
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• Layout Buttons – यह टूलबार पेज िो नवनभन्न लेआउट मे बदलता है जैसे- Normal Layout, Print Layout, Web Layout, 

Reading Layout आनद। यह टूलबार सै्टटस बार िे दानहिी ओर िदनशडत होती हैं। 

• Zoom Buttons – यह बार Layout Buttons िे साथ ही िदनशडत होती है। इसिे द्वारा पेज िो Zoom in या Zoom out िर 

सिते हैं। 

Microsoft Word 2021 Tabs and Options | Microsoft Word 2021 के टैब्स और ऑप्शन्स 

जैसा िी ऊपर बताया गया है माइक्रोसॉफ्ट वर्ड 2021 मे नर्फॉल्ट रूप से 11 टैब्स नदए गए हैं, नजििे अिंतगडत अिेिोिं ऑप्शि उपलब्ध 

होते हैं। इि ऑप्शन्स िा इसे्तमाल िरिे हम र्ाकू्यमेंट िो एनर्ट, फॉमैट, रे्िोरेट आनद िर सिते हैं। िीचे Microsoft Word 2021 

िे सभी टैब्स व उििे नविल्पोिं िे उपयोग िे बारे मे हम आपिो नवस्तररत रूप से बता रहे है। 

1. File Tab 

 
Microsoft Word File Tab Options : यह पहला टैब होता है। इस टैब िे नवनभन्न नविल्प व उििे उपयोग निम्ननलखखत हैं – 

New – इस ऑप्शि िे द्वारा एि ररक्त र्ाकू्यमेंट जोड़ सिते हैं, इसिे अलावा इस ऑप्शि िे द्वारा अिेिोिं ििार िे रेर्ीमेर् 

टेम्पलेट्स िा उपयोग िरिे िया र्ाकू्यमेंट क्रीऐट िर सिते हैं। 

Open – मेमोरी में निसी सुरनक्षत र्ाकू्यमेंट िो खोलिे िे नलए File Menu से Open ऑप्शि िा उपयोग िरते हैं। 

Save – मौजूदा र्ाकू्यमेंट िो सुरनक्षत िरिे िे नलए File Menu में Save ऑप्शि िा उपयोग निया जाता हैं। 

Save As – इस ऑप्शि िे द्वारा र्ाकू्यमेंट िो अन्य फॉमेट मे बदलिर एि िई फाइल मे सेव (Save) िर सिते हैं, जैसे – Pdf, html, 

txt आनद। 

Print – मौजूदा र्ाकू्यमेंट िो निन्ट िरिे िे नलए File Menu से Print ऑप्शि िा उपयोग िरते हैं। इस ऑप्शि िे द्वारा र्ॉकू्यमेंट िा 

िीवू्य भी देख सिते हैं। 

Export – इस ऑप्शि िे द्वारा मौजूदा र्ाकू्यमेंट िो PDF फाइल में एक्स्पोटड िर सिते हैं। 

Share – इस ऑप्शि िे द्वारा मौजूदा र्ाकू्यमेंट िो Microsoft One Drive पर अपलोर् िर अन्य लोगोिं िो शेयर िर सिते हैं। 

Account – यह ऑप्शि Microsoft Word 2021 िे लाईसेंस िो ऐखिवेट िरिे िे नलए तथा अपरे्ट सेनटिंग्स िो मैिेज िरिे िे नलए 

उपयोग निया जाता है। 

Options – Microsoft Word 2021 िी समू्पर्ड सेनटिंग्स िो मैिेज िरिे िे नलए इस ऑप्शि िा उपयोग निया जाता है। 

2. Home Tab 

माइक्रोसॉफ्ट वर्ड होम टैब गु्रप और ऑप्शन्स : होम टैब िे अिंतगडत र्ाकू्यमेंट िो एनर्ट व फॉमैट िरिे से सिंबिंनधत अिेिोिं नविल्प आते 

हैं। इि सभी नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है, जो निम्न ििार हैं- 
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2.1 Clipboard Manager 

खिपबोर्ड मैिेजर नवशेष रूप से िट या िॉपी निए गए र्ाटा िो मैिेज िरिे िे नलए माइक्रोसॉफ्ट ऑनफस िा नर्फॉल्ट फीचर होता 

है, यह ऑनफस पैिेज िी सभी Applications मे समाि रूप से िायड िरता है। इसिे अिंतगडत आिे वाले सभी ऑप्शि निम्ननलखखत हैं। 

Cut – र्ाकू्यमेंट में नलखे टेक्स्ट िो एि थथाि से दूसरे थथाि पर मूव िरिे िे नलए Cut ऑप्शि िा उपयोग िरते हैं। टेक्स्ट िो िट 

िरिे िे नलए टेक्स्ट िो नसलेि िरें गे नफर Cut ऑप्शि पर खिि िरें गे। इसिी शॉटडिट िी Ctrl + C होती हैं। 

Copy – र्ाकू्यमेंट में नलखे टेक्स्ट िो िॉपी िरिे िे नलए टेक्स्ट िो नसलेि िरें गे नफर Copy ऑप्शि पर खिि िरें गे। 

Paste – Cut या Copy निए गए टेक्स्ट िो पेस्ट (Paste) िरिे िे नलए इस ऑप्शि िा उपयोग िरते हैं। 

Paste Special – Cut या Copy निए गए टेक्स्ट िो अनतररक्त फीचर िे साथ पेस्ट िरिे िे नलए इस ऑप्शि िा उपयोग िरते हैं, जैसे 

– नलिंि बिािा, नपक्चर िे रूप में पेस्ट िरिा आनद। 

Format Painter – टेक्स्ट िी फॉमैनटिंग िॉपी िरिे िे नलए इस ऑप्शि िा उपयोग िरते हैं, नजस टेक्स्ट िी फॉमैनटिंग िॉपी िरिी है 

उस टेक्स्ट पर िसडर रखें नफर Format Painter ऑप्शि पर खिि िरें , इसिे बाद उस टेक्स्ट िो नसलेि िरें  नजसपर फॉमैनटिंग 

अप्लाई िरिी हैं। 

2.2 Font 

टेक्स्ट िो फॉमैट िरिे िे नलए Font सेक्शि िे अिंतगडत अिेिोिं नविल्प उपलब्ध होते है जो निम्न ििार हैं – 

Font – र्ाकू्यमेंट में नलखे टेक्स्ट िा िारूप बदलिे िे नलए Font ऑप्शि िा इसे्तमाल िरते हैं। 

Font Size – टेक्स्ट िा साइज़ िम या ज्यादा िरिे िे नलए Font Size ऑप्शि िा इसे्तमाल िरते हैं। 

Bold – टेक्स्ट िो मोटा बिािे िे नलए Bold ऑप्शि िा इसे्तमाल िरते हैं। 

Italic – टेक्स्ट िो नतरछा िरिे िे नलए Italic ऑप्शि िा इसे्तमाल िरते हैं। 

Underline – टेक्स्ट िे िीचे लाइि खीचिे िे नलए Underline ऑप्शि िा इसे्तमाल िरते हैं। 

Superscript – इस ऑप्शि िे द्वारा टेक्स्ट िो सुपरखस्क्रप्ट मोर् में नलख सिते हैं। Ex – X2 यहााँ 2 हो सुपरखस्क्रप्ट फॉमड मे नलखा गया है। 

Subscript – इस ऑप्शि िे द्वारा टेक्स्ट िो सबखस्क्रप्ट मोर् में नलख सिते हैं। Ex – X2 यहााँ 2 हो सखरस्क्रप्ट फॉमड मे नलखा गया है। 

Change Case – टेक्स्ट िो िैनपटल िेस, स्मॉल िेस, सेंटेन्स िेस आनद में बदलिे िे नलए Change Case ऑप्शि िा इसे्तमाल िरते 

हैं। 

Font Color – रिंगीि टेक्स्ट नलखिे िे नलए Font Color ऑप्शि िा इसे्तमाल िरते हैं। 

Highlight Color – सलेिेर् हुए टेक्स्ट िो हाइलाइट िरिे िे नलए इस ऑप्शि िा इसे्तमाल िरते हैं। 

2.3 Paragraph 

टेक्स्ट, लाइि या निसी पैराग्राफ िो अलाइि (Align) िरिे िे नलए Paragraph सेक्शि िे अिंतगडत निम्न नविल्प मौजूद होते हैं – 

Right – टेक्स्ट िो पेज में दानहिी तरफ से नलखिे िे नलए Right ऑप्शि िा इसे्तमाल िरते हैं। 

Left – टेक्स्ट िो पेज में बाईिं तरफ से नलखिे िे नलए Left ऑप्शि िा इसे्तमाल िरते हैं – 

Center – टेक्स्ट िो पेज िे बीच में नलखिे िे नलए Center ऑप्शि िा इसे्तमाल िरते हैं। 

Justify – इस ऑप्शि िे द्वारा र्ाकू्यमेंट में नलखा गया टेक्स्ट दाईिं व बाईिं मानजडि से बराबर सेट हो जाता है। 

Increase/Decrease Indent – निसी पैराग्राफ िो दाएिं  या बाएिं  खखसिािे िे नलए इि ऑप्शि िा इसे्तमाल िरते हैं। इसिे नलए 

पैराग्राफ पर िसडर रखें और ऑप्शि पर खिि िरें। 

Line Height – नलखे गए टेक्स्ट में लाइिोिं िे बीच गैप या से्पस िो अजस्ट िरिे िे नलए इस ऑप्शि िा उपयोग िरते हैं। 

Bullets – निसी जाििारी िी अि-ऑर्डर नलस्ट बिािे िे नलए Bullets ऑप्शि िा इसे्तमाल िरते हैं। जैसे – 

• MS Word 

• MS Excel 

• MS PowerPoint 

Numbering – निसी जाििारी िी ऑर्डर नलस्ट बिािे िे नलए Numbering ऑप्शि िा इसे्तमाल िरते हैं। जैसे – 

1. MS Word 

2. MS Excel 
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3. MS PowerPoint 

2.4 Styles 

स्टाइल िे द्वारा टेक्स्ट िो नवनभन्न िारूपोिं (Styles) में बदल-बदल िर नलखा जा सिता हैं। यहााँ िुछ रेर्ीमेर् स्टाइल्स भी उपलब्ध होती 

हैं इििे अलावा पसिंदीदा स्टाइल्स क्रीऐट भी िर सिते हैं। 

2.5 Editing 

Find – र्ाकू्यमेंट में निसी शब्द या जाििारी िो खोजिे िे नलए Find ऑप्शि िा इसे्तमाल िरते हैं। इसिी शॉटडिट िी Ctrl + F होती 

है। 

Replace – र्ाकू्यमेंट में नलखे टेक्स्ट में निसी शब्द या जाििारी िो निसी अन्य जाििारी से बदलिे िे नलए Replace ऑप्शि िा 

इसे्तमाल िरते हैं। इसिी शॉटडिट िी Ctrl + H होती है। 

Select – र्ाकू्यमेंट िे टेक्स्ट, शेप्स या निसी अन्य ऑबे्जि िो सलेि िरिे िे नलए इस नविल्प िा उपयोग निया जाता है। 

2.6 Add-ins 

इस ऑप्शि िे द्वारा Microsoft Word 2021 िे नलए िई सारे िए फीचसड िो ऐर् (Add) निया जा सिता है। जैसे – Emojis, 

Keyboards, Math Type, GPT for Excel Word आनद। ये फीचसड Microsoft Word 2021 िी फिं क्शिानलटी िो और अनधि बढ़ा देते 

है। 

4. Insert Tab 

 
माइक्रोसॉफ्ट वर्ड इन्सटड टैब गु्रप और ऑप्शन्स : इन्सटड टैब िे अिंतगडत र्ाकू्यमेंट मे पेज, टेबल, मीनर्या, शेप्स, नलिंि, नसिंबल्स आनद िो 

जोड़िे िे नलए अिेिोिं नविल्प आते हैं। इि सभी नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है जो निम्न ििार हैं- 

3.1 Pages 

Pages – र्ाकू्यमेंट में एि ररक्त पेज जोड़िे िे नलए इस ऑप्शि िा उपयोग िरते हैं। 

Cover Pages – र्ाकू्यमेंट िे नलए िवर पेज बिािे  िे नलए Cover Page ऑप्शि िा इसे्तमाल िरते हैं। इसमे िई सारे रेर्ीमेर् िवर 

पेजेस िा सिंग्रह होता है। िवर पेज र्ाकू्यमेंट िा फ्रन्ट पेज होता है, नजसमे र्ाकू्यमेंट से सिंबिंनधत जाििाररयााँ नलखी जाती हैं। 

3.2 Tables 

Insert Table – इस ऑप्शि िे द्वारा र्ाकू्यमेंट में रो और िॉलम से बिी टेबल जोड़ सिते हैं, नजससे निसी ििार िी जाििारी िो रो 

और िॉलम में नलखा जा सिता है। 

Draw Table – इस ऑप्शि िे द्वारा पेंनसल िा उपयोग िरते हुए टेबल र्र ॉ िर सिते हैं, पेंनसल िे उपयोग से मिचाही टेबल बिा 

सिते हैं। 

3.3 Illustrations 

इस सेक्शि िे अिंतगडत र्ाकू्यमेंट मे नवनभन्न ििार िे ऑबे्जि्स िो जोड़ा जा सिता है। र्ाटा िो ग्रानफिल फॉमड मे िसु्तत िरािे िे 

नलए Illustrations सेक्शि िे अिंतगडत निम्न ऑप्शि उपयोग निए जा सिते हैं। 

Pictures – र्ाकू्यमेंट में ऑिलाइि या ऑफलाइि माध्यम से नपक्चर जोड़िे िे नलए इस ऑप्शि िा उपयोग िरते हैं। 

Icons – र्ाकू्यमेंट में नवनभन्न ििार िे आइिन्स जोड़िे िे नलए Icons ऑप्शि िा इसे्तमाल िरते है, इसिे नलए इिंटरिेट ििेक्शि 

होिा जरूरी है। 

Shapes – र्ाकू्यमेंट में नवनभन्न ििार िी आिृनतयााँ जैसे – सिड ल, बॉक्स, नत्रभुज, लाइि, एरो, फ़्लो चाटड आनद जोड़िे िे नलए Shapes 

ऑप्शि िा उपयोग िरते हैं। 

3D Models – इस नविल्प िे द्वारा र्ॉकू्यमेंट मे अिलाइि नवनभन्न ििार िे 3D Artistic नर्जाइि ऐर् िर सिते हैं। इि नर्ज़ाइनििंग 

मॉरे्ल्स िो 360 नर्ग्री घुमाया जा सिता है। यहााँ हर एि नर्पाटड से सिंबिंनधत 3D Models उपलब्ध हैं नजििा इसे्तमाल निसी टॉनपि िो 

ग्रानफि िे साथ explain िरिे िे नलए निया जा सिता है। 

Smart Art – स्माटड आटड एि ग्रानफिल ऑबे्जि होता है, इििा इसे्तमाल िरिे निसी जाििारी जैसे टेक्स्ट, नपक्चर आनद िो एि 

साथ List, Process, Cycle, Hierarchy, Pyramid आनद िारूपोिं में िदनशडत िरा सिते हैं।  

Charts – चाटड भी एि ग्रानफिल ऑबे्जि होता है, चाटड िा इसे्तमाल िरिे रो और िॉलम में नलखी जाििारी िो ग्रानफिली िदनशडत 

िरा सिते हैं। जैसे निसी शीट में दजड निसी ििं पिी िी वानषडि सेल्स ररपोटड िो चाटड िी मदद से िसु्तत िर सिते हैं। 
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Screenshot – इस नविल्प िे द्वारा र्ाकू्यमेंट ििं पू्यटर स्क्रीि िे निसी भी नहसे्स िा स्क्रीिशॉट जोड़ सिते हैं। 

नोट : ऑबे्जि िोई नपक्चर, आइिाि, शेप, चाट्डस आनद हो सिते हैं, जब निसी ऑबे्जि िो नसलेि निया जाता है तो सेलेिेर् 

ऑबे्जि िो ििं टर ोल िरिे िे नलए Format िाम से एि अन्य टैब (Tab) स्वयिं से ओपि (Open) हो जाता है, नजसमे अलग-अलग 

ऑबे्जि्स िे अिुसार नविल्प नदए होते हैं तथा िुछ नविल्प सभी िे नलए िॉमि होते हैं। ये सभी नविल्प निम्ननलखखत हैं – 

Object Controlling Options in Format Tab 

• Styles – इसिे द्वारा ऑबे्जि िी स्टाइल िो बदल सिते हैं तथा निसी ऑबे्जि जैसे शेप, नपक्चर आनद िो नवनभन्न िारूपोिं 

मे बदल सिते हैं। 

• Fill Color – अगर िोई ऑबे्जि शेप है तो उसमे रिंग भर सिते हैं। 

• Outlines – इस ऑप्शि िे द्वारा शेप या ऑबे्जि िी आउट्लाइि िलर और मोटाई मैिेज िर सिते हैं। 

• Effects – ऑबे्जि पर नवनभन्न ििार से इफेि लागू िर सिते हैं, जैसे – र्र ॉप शैर्ो, ररफे्लक्शि, ग्लो आनद। 

• Positions – ऑबे्जि िो पेज में निस पोजीशि पर सेट िरिा है, यह सेट िर सिते हैं जैसे – Top, Bottom, Center, Right, 

Left, Middle. 

• Text Wrap – र्ाकू्यमेंट में नलखे टेक्स्ट िो ऑबे्जि िे साथ नफट िरिे िे नलए Text Wrap ऑप्शि िा इसे्तमाल िरते हैं, 

निसी ऑबे्जि िो In Line, Tight, Square, Behind Text, Infront of Text आनद रूप में सेट िर सिते हैं। 

• Arrange – र्ाकू्यमेंट में अगर एि से अनधि ऑबे्जि जोडे़ गए हैं, तथा उिमे से निसी ऑबे्जि िो निसी ऑबे्जि िे 

ऊपर या िीचे िरिा है तो Arrange सेक्शि िे अिंतगडत Send to Back/Bring to Front ऑप्शि िे द्वारा िर सिते हैं। 

• Align – मल्टीपल ऑबे्जि्स िो एि साथ वनटडिली या होररजॉन्टली अलाइि िरिे िे नलए इस ऑप्शि िर इसे्तमाल िरते 

हैं। 

• Group – एि से अनधि ऑबे्जि िो एि साथ गु्रप िरिे एि ऑबे्जि बिािे िे नलए Group ऑप्शि िा इसे्तमाल िरते हैं, 

गु्रप निए गए ऑबे्जि िो पुिः  अलग िरिे िे नलए Ungroup ऑप्शि िा इसे्तमाल िरते हैं। 

• Rotate – निसी नपक्चर, शेप या ऑबे्जि िो 90, 180, 360 नर्ग्री ति घुमािे िे नलए Rotate ऑप्शि िा इसे्तमाल िरते हैं। 

• Size – इसिे द्वारा ऑबे्जि िी हाइट व चौड़ाई अजस्ट िर सिते हैं। 

3.4 Media 

मीनर्या सेक्शि िे अिंतगडत अिलाइि वीनर्योज़ िे नलिंि जैसे यूटू्यब वीनर्योज़ (You tube Videos) िो ऐर् िर सिते हैं नजसे 

Microsoft Word 2021 मे ही पे्ल िर सिते हैं। 

3.5 Links 

र्ाकू्यमेंट मे निसी टेक्स्ट पर नलिंि लगािे िे नलए निम्न ऑप्शन्स िा उपयोग निया जा सिता है। 

Links – र्ाकू्यमेंट में नलखे निसी टेक्स्ट या जाििारी पर निसी बाहरी पेज, यूआरएल, फाइल, फोल्डर आनद िा नलिंि लगा सिते हैं। 

ऐसा िरिे िे नलए टेक्स्ट नसलेि िरें गे नफर Links ऑप्शि पर खिि िरिे नजस जाििारी िा नलिंि बिािा है वह ऑप्शि चुिेंगे। 

नलिंि िी शॉटडिट िुिं जी Ctrl + K होती हैं। 

Bookmarks – यनद र्ाकू्यमेंट मे एि से अनधि पेजेस हैं तो र्ाकू्यमेंट िी मुख्य जाििाररयोिं िे बुिमाक्सड क्रीऐट िर सिते हैं, तानि 

उस इिफामेशि पर नबिा स्क्रॉल निए र्ायरेि पहुिंचा जा सिे। र्ाकू्यमेंट में नजस जाििारी िा बुिमािड  क्रीऐट िरिा है उस 

जाििारी िो नसलेि िरे इसिे बाद Bookmark ऑप्शि पर खिि िरें  और नबिा से्पस नदए निसी िाम से सेव िरें। बिाए गए 

बुिमाक्सड िो एके्सस िरिे िे नलए बुिमािड  ऑप्शि िा ियोग िरें गे।  

Cross Reference – क्रॉस रेफ्रन्स िे द्वारा र्ॉकू्यमेंट िी जाििाररयोिं िे नलए क्रॉस रेफ्रन्स बिा सिते हैं, इससे एि लेबल िे द्वारा 

र्ॉकू्यमेंट िी उि जाििाररयोिं ति आसािी से पहुिंचा जा सिता है नजस जाििारी िे नलए क्रॉस रेफ्रन्स बिाया गया है। क्रॉस रेफ्रन्स 

बिािे िे नलए हेनर्िंग्स उपयोग भी निया जा सिता है। इसिे नलए जहािं क्रॉस रेफ्रन्स बिािा है वहााँ िसडर रखे और नफर Insert>Cross 

Reference ऑप्शि पर खिि िरें। इसिे बाद Reference Type मे Heading नसलेि िरें , नफर वह हेनर्िंग चुिे नजसिा क्रॉस रेफ्रन्स 

बिािा है और Ok िरें। इस तरह से उस हेनर्िंग िे नलए क्रॉस रेफ्रन्स लेबल बि जाएगा, अब लेबल पर Ctrl+click िरें गे तो उस हेनर्िंग 

पर पहुाँच जाएिं गे। 

3.6 Comments 

िमेन्ट िा उपयोग निसी टेक्स्ट या जाििारी पर िोई िोट नलखिे िे नलए निया जा सिता है, नजसे नछपाया या नदखाया जा सिता है। 

3.7 Header and Footer 

Header – र्ाकू्यमेंट िे िते्यि पेज पर एि ही जैसी सूचिा या जाििारी िो Header ऑप्शि िे द्वारा िदनशडत िरा सिते है। हेर्र में 

िोई टेक्स्ट, पेज ििंबर, नपक्चर आनद जोड़ सिते हैं। हेर्र पेज िे टॉप (Top) एररया में िदनशडत होता है। 
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Footer – फूटर पेज िे निचले (Bottom) एररया में िदनशडत होता है, इसिा िायड भी हेर्र िे समाि ही होता है। 

Page Number – र्ाकू्यमेंट में एि से अनधि पेज होिे पर इस ऑप्शि िे द्वारा िते्यि पेज पर पेज ििंबर जोड़ सिते हैं। 

3.8 Text- टेक्स्ट बॉक्स एि ऑबे्जि होता है, इसे र्ाकू्यमेंट में िही िं भी पे्लस निया जा सिता हैं। टेक्स्ट बॉक्स में टेक्स्ट िो मल्टीपल 

र्ाइरेक्शि में नलख सिते हैं। 

Quick Parts – खिि पाटड Microsoft Word िा एि उपयोग फीचर है, इसिे द्वारा ऐसी जाििाररयोिं िो सुरनक्षत निया जा सिता है 

नजने्ह बार-बार उपयोग मे लाया जाता हो, जैसे – िोई िाम, पता आनद। जाििारी िो Quick Part मे सेव िरिे िे नलए जाििारी िो 

सलेि िरें  और Insert>Text>Quick Part>Save Selection to Quick Part ऑप्शि पर खिि िरें , तथा िाम, लोिैशि व अन्य 

जाििारी भरिर Ok िरें। Quick Part िे अिंदर िई नविल्प आते हैं जैसे – Document Property िे अिंदर निसी र्ाकू्यमेंट से ररलेटेर् 

िई नविल्प उपलब्ध होते है जैसे – Author, Subject, Title, Category, Company, Publish Date आनद। इि फील््डस िो र्ॉकू्यमेंट मे 

इन्सटड िर जाििारी िो अपरे्ट निया जा सिता है। 

Word Arts – वर्ड आटड रे्िोरेनटव टेक्स्ट ऑबे्जि होते हैं, इने्ह र्ाकू्यमेंट में िही िं भी पे्लस निया जा सिता है। सेलेिेर् वर्ड आटड िे 

नलए अलग से Format टैब ओपि होता है जहािं से इसे नवनभन्न ऑप्शन्स िे द्वारा िस्टमाइज़ भी निया जा सिता है। 

Drop Cap – इस ऑप्शि िे द्वारा निसी पैराग्राफ िा पहला अक्षर बड़ा बिा सिते हैं, तानि यह पता चल सिे नि िया सेक्शि िहा से 

स्टाटड हो रहा है। 

Signature Line – इस नविल्प िे द्वारा निसी र्ाकू्यमेंट जैसे फॉमड, सनटडनफिेट आनद मे हस्ताक्षर रेखा (Signature Line) जोड़ सिते 

हैं। नसगे्नचर लाइि जोड़िे िे नलए माउस िसडर रखें नफर इस ऑप्शि पर खिि िरें  और िाम तथा टाइटल भरें  और Ok ऑप्शि पर 

खिि िरें। 

Object – इस नविल्प िे द्वारा र्ॉकू्यमेंट मे अन्य निसी एप्लीिेशि िे ऑबे्जि जोडे़ जा सिते हैं, तथा फाइल िो नबिा बिंद निए 

उिपर र्ायरेि िायड भी निया जा सिता है। जैसे – MS Paint, Excel Spreadsheet, Photoshop Document इत्यानद। 

3.9 Symbols 

Equation – इस नविल्प िे द्वारा मैथ िी इिैशि (Equation) क्रीऐट िर सिते है। 

Symbols – ऐसे नसिंबल्स जो िीबोर्ड में उपलब्ध िही िं होते हैं, उने्ह इस ऑप्शि िे द्वारा र्ाकू्यमेंट में जोड़ सिते हैं। इसिे अिंतगडत 

अलग-अलग फॉन्ट िे अिुसार हजारोिं नसिंबल्स उपलब्ध होते हैं। जैसे – Smileys, Characters, Operators, Arrows आनद।   

5. Draw Tab 

 
र्र ॉ टैब िे अिंतगडत र्ाकू्यमेंट में निसी ऑबे्जि िो र्र ॉइिंग िरिे िे नलए नवनभन्न ििार िे र्र ॉइिंग टूल्स जैसे िलर पेि, इरेजर, नसलेक्शि, 

से्कल आनद नविल्प मौजूद होते हैं, नजििी मदद से मिचाहा ऑबे्जि जैसे – Circle, Tringle, Square या िोई अन्य Shape र्र ॉ िर 

सिते हैं। 

6. Design Tab 

 
माइक्रोसॉफ्ट वर्ड नर्जाइि टैब गु्रप और ऑप्शन्स : नर्जाइि टैब िे अिंतगडत र्ाकू्यमेंट िो फॉमैट िरिे व सजािे से सिंबिंनधत अिेिोिं 

नविल्प आते हैं। यह सभी नविल्प निम्न ििार हैं- 

Themes – थीम्स िा उपयोग िरिे र्ाकू्यमेंट िे ओवरआल लुि और अपीयरेन्स जैसे – रिंग, फॉन्ट स्टाइल आनद िो बदल सिते हैं। 

Page Border – पेज पर बॉर्डर लगािे िे नलए Page Border ऑप्शि िा इसे्तमाल िरते हैं। पेज बॉर्डर िे अिंतगडत अिेिोिं स्टाइनलश 

पेज बॉर्डर उपलब्ध होते हैं नजने्ह पेज िे चारोिं ओर लगा सिते हैं। 

Page Color – इस ऑप्शि िे द्वारा पेज िे बैिग्राउन्ड में मिचाहा रिंग सेट िर सिते हैं। 
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Watermarks – वाटर मािड  िे द्वारा पेज िे बैिग्राउन्ड में िोई टेक्स्ट या इमेज िो सेट िर सिते हैं, जो हर पेज पर समाि रूप से 

िदनशडत होता है। इसिा िभाव र्ाकू्यमेंट में नलखे टेक्स्ट पर िही िं पड़ता है। इसिा उपयोग अक्सर लोगो या िॉपीराइट आनद जाििारी 

िदनशडत िरािे िे नलए निया जाता है। 

7. Layout Tab 

 
माइक्रोसॉफ्ट वर्ड लेआउट टैब गु्रप और ऑप्शन्स : लेआउट टैब िे अिंतगडत र्ाकू्यमेंट िी पेज सेनटिंग सिंबिंनधत नविल्प आते हैं। इि सभी 

नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है जो निम्न ििार हैं- 

6.1 Page Setup 

र्ाकू्यमेंट िे लेआउट िो सेटअप िरिे िे नलए नवनभन्न ििार िे ऑप्शि Page Setup सेक्शि िे अिंतगडत उपलब्ध होते हैं जो निम्न 

ििार हैं। 

Margins – मानजडि पेज िे चारोिं ओर िा के्षत्र होता है, इसे Margin ऑप्शि िे द्वारा सेट निया जा सिता है। पेज िे Top, Left, Right, 

Bottom में नजतिा मानजडि सेट िरें गे, पेज में टेक्स्ट या जाििारी उतिा मानजडि छोड़िर नलखी जाएगी। 

Orientation – ओरीएने्टशि ऑप्शि िे द्वारा पेज िो Portrait या Landscape मोर् में बदल सिते हैं। पोटर ेट मोर् में पेज ऊिं चाई मोर् 

में होता है, लैंर्सै्कप मोर् में पेज चौड़ाई मोर् में होता है। 

Size – इस ऑप्शि िे द्वारा पेज निन्ट िरिे िे नलए नििंटर पेपर िे अिुसार पेज िा साइज़ सेट िर सिते हैं जैसे – Letter, A4, A3, 

Legal आनद। 

Columns – पेज में टेक्स्ट िो एि से अनधि िॉलम में नलखिे िे नलए Column ऑप्शि िा इसे्तमाल िरते हैं। 

Line Numbers – इस ऑप्शि िा उपयोग िरिे र्ाकू्यमेंट िी लाइिोिं या पैराग्राफ पर 

 सीरीअल ििंबर सेट िर सिते हैं। 

Hyphenation – जब निसी लाइि िे अिंत मे निसी बडे़ शब्द िो नलखिा हो और से्पस िम हो तो इस ऑप्शि िो ऑि िरिे पर लिंबा 

शब्द रै्श (-) िे साथ नलख नदया जाता है, अथाडत शब्द िे जीतिे अक्षर नलख सिते हैं नलख जाएिं गे बािी िई लाइि मे चले जाएिं गे। 

6.2 Paragraph इस सेक्शि िे अिंतगडत पैराग्राफ िी सै्पनसिंग (Spacing) िो ििं टर ोल िर सिते हैं। जैसे निसी पैराग्राफ िो Top, 

Bottom, Right, Left नितिा से्पस देिा है यह सेट िर सिते हैं। 

6.3 Arrange 

Position – निसी शेप या नपक्चर िो पेज िे निस भाग मे ऑटोमैनटि सेट िरिा है, इस नविल्प िे द्वारा िर सिते हैं। 

Word Wrap – निसी शेप या नपक्चर िो पेज मे सेट िरिे पर उस पेज मे नलखा टेक्स्ट निस ििार से बे्रि होगा यह सेट िर सिते हैं। 

Bring Forward/Send Backward – निसी शेप या नपक्चर िो निसी अन्य शेप या नपक्चर िे ऊपर या िीचे ले जािे िे नलए इस 

नविल्प िा उपयोग िरते हैं। 

Selection Pane – इस ऑप्शि पर खिि िरिे से एि Pane Window खुल जाती है, नजसमे र्ॉकू्यमेंट मे जोडे़ गए सभी शेप्स िी 

जाििारी िदनशडत होती है। िई अलग-अलग शेप्स िो एि साथ Selection Pane िे द्वारा ििं टर ोल निया जा सिता है। 

Align – िई शेप्स िो एि साथ Vertically या Horizontally अलाइि िरिे िे नलए इस नविल्प िा उपयोग िरते हैं। इसिे नलए सभी 

शेप्स िो एि साथ नसलेि िरें  और नदए गए ऑप्शि पर खिि िरें। 

Group – िई शेप्स िो एि साथ गु्रप या अिगु्रप (Group or Ungroup) िरिे िे नलए इस नविल्प िा उपयोग िरते हैं। 

Rotate – निसी शेप या नपक्चर िो 90, 180 या 360 नर्ग्री घुमािे िे नलए इस नविल्प िा इसे्तमाल िरते हैं। 

8. Reference Tab 

 
माइक्रोसॉफ्ट वर्ड रेफरेन्स टैब गु्रप और ऑप्शन्स : रेफरेन्स टैब िे अिंतगडत ऐसे नविल्प मौजूद होते है जो निसी र्ाटा िे नलए रेफरेन्स हैं 

बिाते हैं। इि सभी नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है, जो निम्न ििार हैं- 
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7.1 Table of Contents 

Table of Contents – र्ाकू्यमेंट मे हेनर्िंग्स िे आधार पर टेबल ऑफ ििं टेन्ट क्रीऐट िर सिते हैं। यह र्ाकू्यमेंट िी शुरुआत में 

िदनशडत होिे वाली एि ििार िी सूची होती है जो यह िदनशडत िरती है नि र्ाकू्यमेंट में िौि सी हेनर्िंग निस पेज पर है। इसे बिािे िे 

नलए Table of Contents पर खिि िरें  और एि फॉमैट चुिें। 

Add Text – टेबल िी सूची मे हेनर्िंग से सिंबिंनधत िुछ जाििारी जोड़िे िे नलए इस नविल्प िा इसे्तमाल िरते हैं। 

Update Table – Table of Content बिािे िे बाद यनद र्ाकू्यमेंट मे और भी हेनर्िंग जोड़ी जाती हैं तो उसे Table of Contents मे लािे 

िे नलए इस नविल्प िा उपयोग िरते हैं। 

7.2 Footnotes 

Insert Footnote – इस नविल्प िा उपयोग पेज िे अिंत (Last) मे पेज से सिंबिंनधत इिफामेशि जोड़िे िे नलए िरते हैं। 

Insert Endnote – इस नविल्प िा उपयोग र्ाकू्यमेंट िे अिंत (Last) मे र्ाकू्यमेंट से सिंबिंनधत इिफामेशि जोड़िे िे नलए िरते हैं। 

7.3 Citations & Bibliography 

अगर आप िोई ररसचड पेपर नलख रहे होिं तो उसमे ये देिा जरूरी हो जाता है नि आपिे निसी खास से्टटमेंट िे नलए िहााँ से अध्ययि 

निया है या िोई फामूडला, तथ्य या पहले िे ररसचड िे पररर्ाम वगैरह नजसे आपिे आधार बिाया है उसे िहााँ से नलया है। 

अगर आप िोई लेख भी नलख रहे हैं तो आपिो िीचे साइटेशि र्ालिे पड़ते हैं तानि ये पता चले िी आपिी नलखी चीजोिं िा आधार 

क्या है और वो िहााँ से आया है। एमएस वर्ड  में भी आप अपिे र्ॉकू्यमेंट में साइटेशि या नबबनलयोग्राफी िो जोड़ सिते हैं तानि वो और 

भी िमानर्ि लगे। 

Insert Citations – इस नविल्प िे द्वारा Citations Insert िरा सिते हैं। इसिे नलए इस नविल्प पर खिि िरें  और Add new 

Source पर खिि िरें  और दी जाििारी िो भरें। इसी ििार से एि से अनधि Citations क्रीऐट िर सिते हैं। अब नजस Citation िो 

नजस टेक्स्ट िे साथ जोड़िा है उस टेक्स्ट िो नसलेि िरे और Citation नलस्ट मे क्रीऐट निए गए Citation पर खिि िरें। इस तरह से 

टेक्स्ट िे लास्ट मे बै्रनिट िे अिंदर (Name, Year) िाम से Citation इन्सटड हो जाएगा, नजसिी Details िो Bibliography ऑप्शि िे द्वारा 

र्ाकू्यमेंट िे आखखर (Last) मे या िही िं पर भी इन्सटड िर सिते हैं। 

Manage Sources – इस नविल्प िे अिंतगडत सभी Citations िी नलस्ट िदनशडत होती हैं नजििे सोसड (Source) िो दोबारा एनर्ट 

(Edit) निया जा सिता है। Manage Source िे अन्तगडत Master List व Current List िदनशडत होती है, Master List मे ऐसे Citations 

िी नलस्ट िदनशडत होती है जो सभी र्ाकू्यमेंट मे िदनशडत होती है तथा Current List िे अिंतगडत िेवल वतडमाि र्ाकू्यमेंट िे नलए 

Citations िी नलस्ट िदनशडत होती है। 

Styles – यहााँ Citations िे नलए एि स्टाइल चुि सिते हैं, जो जोडे़ गए Citations िो नवनभन्न िारूपोिं मे िदनशडत िरता है। 

Bibliography – यह ऑप्शि एि से अनधि क्रीऐट निए गए Citations िी Detailed नलस्ट िो िदनशडत िरता है, नजसे र्ाकू्यमेंट मे 

इस ऑप्शि िी मदद से जोड़ा जा सिता है। 

9. Mailings Tab 

 
माइक्रोसॉफ्ट वर्ड मेनलिंग टैब गु्रप और ऑप्शन्स : मैनलिंग टैब िे अिंतगडत लेटर व पत्र भेजिे िे नलए नवनभन्न नविल्प आते है। इि सभी 

नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है जो निम्न ििार हैं- 

8.1 Create 

Envelopes – यह नविल्प तब उपयोग िरते हैं जब निसी िो िोई पत्र भेजिा होता है। इस नविल्प िे द्वारा नलफाफे पर ररटिड एर्र ैस 

(Return Address) और नर्लीवरी एर्र ैस (Delivery Address) निन्ट िरा सिते हैं तथा नलफाफे िे नलए नवनभन्न ििार िे साइज़ भी चुि 

सिते हैं। 

Labels – लेबल ऑप्शि िे द्वारा एर्र ैस िे छोटे-छोटे स्टीिर तैयार िर सिते हैं नजने्ह नलफाफोिं पर नचपिा सिते हैं। इसिे अलावा 

स्टीिर बिािर सीर्ी/र्ीवीर्ी व अन्य निसी िोर्ि आनद पर भी नचपिा सिते हैं। 

8.2 Start Mail Merge 

मेल मजड  िे द्वारा एि ही समय में िई िाप्तिताडओिं िो ईमेल पत्र भेजा जा सिता है। जैसे िोई इखिटैशि िार्ड, िोई सूचिा आनद। 

पत्र में िाप्तिताडओिं िे नलए एर्र ैस ब्लॉि, ग्रीनटिंग लाइि आनद जोड़ सिते हैं, नजसमे अलग-अलग िाप्तिताडओिं िी अलग-अलग नर्टेल्स 
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िो मजड िरा सिते हैं। इसिे अलावा मेल मजड िा उपयोग िरिे एि ही बार में िई िमडचाररओिं िे ID Cards, Payment Slip भी तैयार 

िी जा सिती हैं। 

Start Mail Merge – इस नविल्प िे द्वारा मेल मजड (Mail Marge) स्टाटड िर सिते हैं तथा चुि सिते हैं नि मेल मजड िे द्वारा निस 

ििार िा र्ॉकू्यमेंट िा उपयोग िरिा है। 

Select Recipient – इस नविल्प िे द्वारा िाप्तिताड नलस्ट नसलेि िर सिते हैं, या िई नलस्ट भी क्रीऐट िर सिते हैं नजि लोगोिं िो 

पत्र भेजिा है। 

Edit Recipient List – इस नविल्प िे द्वारा नसलेि िी गई िाप्तिताड नलस्ट िो एनर्ट िर सिते हैं, नि निि िाप्तिताडओिं िो लेटर 

या मेल भेजिा है तथा निििो िही िं। 

8.3 Write and Insert Fields 

Highlight Merge Fields – यह नविल्प सभी इन्सटड िी गई फील््डस (Fields) िो हाईलाइट िरता है, इससे पत्र इन्सटड िी गई 

फील््डस िो पहचाििे मे मदद नमलती है। 

Address Block – यह नविल्प एर्र ैस ब्लॉि िो जोड़ता है। लेटर मे जहािं पर भी िाप्तिताड िा एर्र ैस िदनशडत िरािा है वहााँ िसडर रखे 

और Address Block पर खिि िरें। 

Greeting Line – इस नविल्प िे द्वारा िाप्तिताड िे नलए एि ग्रीनटिंग लाइि जोड़ सिते हैं, जैसे – Dear (Name), 

Insert Merge Field – इस नविल्प िे द्वारा िाप्तिताड नलस्ट (Recipient List) से निसी फील्ड िो इन्सटड िर सिते हैं। जैसे – Phone 

No, Company Name आनद। जहािं भी फील्ड इन्सटड िरिी है वहााँ िसडर रखें और Insert Merge Field पर खिि िरें। 

8.4 Preview Results 

इस सेक्शि िा उपयोग Mail Merge िा िीवू्य (Preview) ररजल्ट देखिे िे नलए निया जाता है। नजतिे भी िाप्तिताड िो ईमेल/लेटर 

भेजा जाएगा उसिा िारूप िैसा नदखेगा इस ऑप्शि िे द्वारा देख सिते हैं। 

8.5 Finish & Merge 

इस ऑप्शि िे द्वारा मेल मजड िम्प्प्लीट िर सिते हैं। इसिे द्वारा िते्यि िाप्तिताड िो सीधे ईमेल भेज सिते हैं, या नफर सभी िाप्तिताड 

िी लेटर िॉपी िो एि िए र्ॉकू्यमेंट में ओपि िर निन्ट िर सिते हैं या नर्टेल्स िो एनर्ट भी िर सिते हैं। 

10. Review Tab 

 
माइक्रोसॉफ्ट वर्ड रीवू्य टैब गु्रप और ऑप्शन्स : रीवू्य टैब िे अिंतगडत र्ाकू्यमेंट िी जािंच व वेरीफाई िरिे से सिंबिंनधत नविल्प आते हैं। 

इि सभी नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है जो निम्न ििार हैं- 

9.1 Proofing 

Spelling and Grammar – र्ाकू्यमेन्ट में नलखे गए टेक्स्ट िी से्पनलिंग और ग्रामेनटिल गलनतयोिं िो जााँचिे व ठीि िरिे िे नलए 

Spelling and Grammar ऑप्शि िा उपयोग निया जाता है। यह ऑप्शि स्वचानलत रूप से िायड िरता है तथा निसी गलती िे नलए 

पॉनसबल सजेशि भी िसु्तत िरता है। 

Thesaurus – इस ऑप्शि िे द्वारा निसी शब्द िे अिेिोिं समािाथी शब्द खोज सिते हैं। 

Word Count – र्ाकू्यमेंट में नलखे िुल अक्षर, शब्द, पैराग्राफ, लाइिंस, पेजेस आनद िो Word Count ऑप्शि िे द्वारा देखा जा 

सिता है। 

9.2 Speech 

Read Aloud – इस नविल्प िे द्वारा टेक्स्ट िो सुिा (Listen) जा सिता है। 

9.3 Language 

Translate – इस नलिल्प िे द्वारा सलेिेर् टेक्स्ट या पूरे र्ाकू्यमेंट िो निसी भी भाषा मे अिुवाद (Translate) निया जा सिता है। 

Language – इस नविल्प िे द्वारा Translation सनवडसेज़ िे नलए भाषाएिं  सेट िर सिते हैं। 

9.4 Comments 

Comments – इस ऑप्शि िे द्वारा र्ाकू्यमेंट में नलखी निसी जाििारी पर िमेन्ट िे जररए िोई अन्य जाििारी या नटप्पर्ी जोड़ 

सिते हैं, इने्ह जरूरत िे अिुसार नछपाया, देखा व नर्लीट भी निया जा सिता है। 

9.5 Tracking 
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Track Changes – र्ाकू्यमेंट में बदलाव या एनर्ट िरिे िे नलए Track Changes ऑप्शि िो ऑि िर सिते हैं, तथा निए गए 

बदलावोिं िो ररनवनविंग पेि (Reviewing Pane) से देख जा सिता है। 

Changes – इसिे द्वारा एि बार एनर्ट निए गए र्ाकू्यमेंट िो पुिः  वेरीफाई निया जा सिता है, नजससे निए गए बदलावोिं िो एके्सप्ट 

(Accept) या ररजेि (Reject) िर सिते हैं। 

9.6 Compare Document 

इस ऑप्शि िे द्वारा निन्ही दो र्ॉकु्यमेंट िो एि दूसरे िे साथ तुलिा िरिे देखा जा सिता है, तथा र्ाकू्यमेंट िी जाििाररयोिं िो एि 

िए र्ाकू्यमेंट में िम्बाइि भी निया जा सिता है। 

9.7 Protect 

Restrict Editing – इस नविल्प िे द्वारा र्ाकू्यमेंट िो एि पासवर्ड िे द्वारा िोटेि निया जा सिता है। नजससे िोई अन्य पसडि 

र्ाकू्यमेंट िे साथ छेड़-छाड़ िही िं िर सिता है। 

11. View Tab 

 
माइक्रोसॉफ्ट वर्ड वू्य टैब गु्रप और ऑप्शन्स : वू्य टैब िे द्वारा र्ाकू्यमेंट िो नवनभन्न नविल्पोिं िे साथ देखा जा सिता है। इि सभी 

नविल्पोिं िो नवनभन्न गु्रप्स मे बािंटा गया है जो निम्न ििार हैं- 

10.1 Document Layouts 

Read Mode – यह मोर् र्ॉकु्यमेंट िो निताब िी भािंनत पढ़िे िे नलए इसे्तमाल निया जाता है। 

Web layout – यह मोर् र्ाकू्यमेंट िो वेब पेज िे रूप में िदनशडत िरािे िे नलए इसे्तमाल निया जाता है। इस मोर् मे र्ाकू्यमेंट िे 

सभी पेज एि ही पेज मे बदल जाते हैं। 

Print Layout – यह नर्फॉल्ट मोर् होता है, यह मोर् र्ाकू्यमेंट िो पेज बाई पेज िदनशडत िरता है तथा निन्ट िरािे िे नलए इसे्तमाल 

निया जाता है। 

Outline View – इस मोर् मे र्ॉकू्यमेंट िी हेनर्िंग, सबहेनर्िंग व टेक्स्ट िो शो/हाइर् (Show/Hide) िरिे देखा जा सिता है। 

10.2 Immersive 

Focus – यह एि ऐसा नविल्प है नजसिे द्वारा र्ाकू्यमेंट िो फोिस मोर् मे देखा जा सिता है। इसिा मतलब र्ाकू्यमेंट टेक्स्ट िे 

अलावा बािी िे अन्य नहसे्स नछप जाते हैं, तथा एररया बै्लि हो जाते है। 

Immersive Reader – इस नविल्प िे साथ र्ाकू्यमेंट िो रीर् (Read) िरिे िे नलए िुछ ऐसे नविल्प नमलते हैं जो रीनर्िंग 

इक्स्पीरीअन्स िो बेहतर बिाते हैं। 

• Column Width – इस नविल्प िे साथ टेक्स्ट िॉलम िो चौड़ा पतला िर सिते है। 

• Page Color – इस नविल्प िे द्वारा पेज िलर िो मिचाहा सेट िर सिते हैं। 

• Line Focus – इस नविल्प िे द्वारा टेक्स्ट िा नजतिा नहस्सा पढ़ा जा रहा है वही नवज़बल रहता है, बािी टेक्स्ट पर टर ािंसपरेन्ट 

लेयर आ जाती है। 

• Text Spacing – इस नविल्प िे द्वारा टेक्स्ट िी लाइि व वर्ड सै्पनसिंग बढ़ािर पढ़ा जा सिता है। 

10.3 Show/Hide 

Ruler – र्ाकू्यमेंट में रूलर िो नदखािे िे नलए इसे चेि िरें , रूलर मानजडि िो मैिेज िरिे में सहायि होता है। 

Grid Lines – र्ाकू्यमेंट में नग्रर् लाइि नदखािे िे नलए इसे चेि िरें। नग्रर् लाइि ऑबे्जि िो मैिेज िरिे में सहायि होती हैं। 

Navigation Pane – िेवीगेशि पेि नदखािे िे नलए इसे चेि िरें , इसिी मदद से र्ाकू्यमेंट में हेनर्िंग्स व पेजेस िो िेनवगेट निया जा 

सिता है। 

10.4 Zoom ज़ूम सेक्शि िे अिंतगडत पेज िो नवनभन्न ििार से ज़ूम िर सिते हैं। जैसे – 100% ज़ूम, Page Width ज़ूम, Multiple Page 

Zoom आनद। 

10.5 Window 

New Window – इस नविल्प िे द्वारा एि िई नविंर्ो इन्सटड िी जा सिती है। 

Arrange All – इस नविल्प िे द्वारा एि से अनधि नविंर्ो िो Vertically या Horizontally व्यवखथथत निया जा सिता है। 
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Split – इस नविल्प िे द्वारा निसी नविंर्ो िो दो भागोिं मे तोड़ा जा सिता है। 

View Side by Side – इस नविल्प िे द्वारा दो नविंर्ो िो साइर् बाई साइर् रखिर उििी जाििाररयोिं िो देखा जा सिता है। 

Switch Window – इस नविल्प िे द्वारा निसी ऐखिव नविंर्ो िो अन्य नविंर्ो िे साथ खस्वच निया जा सिता है। 

10.6 Macros यह एि िोग्राम है नजसिा उपयोग माउस नक्रयाओिं और िीस्टर ोक्स सनहत निसी िायड िो ररिॉर्ड  िरिे िे नलए निया 

जाता है। उदाहरर् िे नलए ररिॉर्ड निया गया मैक्रो र्ाटा िोई भी टेम्पलेट हो सिता है। मैक्रो फीचर दोहरािे योग्य िाम िे नलए सबसे 

उपयोगी है, यनद िोई िाम हम समय-समय पर दोहराते हैं, तो हम इसे Macro िा उपयोग िरिे ररिॉर्ड िर सिते हैं और 

आवश्यिता होिे पर रि िरा सिते हैं। 

• Record a Macro – इस ऑप्शि िे द्वारा िया मैक्रो ररिार्ड िर सिते हैं, ध्याि रहे मैक्रो िाम में से्पस िही िं होिा चानहए। 

• Run a Macro – इस ऑप्शि िे द्वारा ररिार्ड निए गए मैक्रो िो रि िरा सिते हैं। 

12. Help Tab 

 
हेल्प टैब िे अिंतगडत Microsoft Word 2021 से सिंबिंनधत नवनभन्न जाििारी िाप्त िर सिते हैं। 

Help & Support:- निसी ऑप्शि से सिंबिंनधत जाििारी िो Help ऑप्शि में जािर सचड िर सिते हैं। 

Contact Support – इस ऑप्शि िे द्वारा निसी समस्या िे बारे मे पूछा जा सिता है। जैसे – Microsoft Word 2021 िा िोई 

ऑप्शि िायड िही िं िर रहा है, तो समस्या िो नलखिर जाििारी िर सिते हैं। 

Show Training – इस ऑप्शि िे द्वारा माइक्रोसॉफ्ट वर्ड से सिंबिंनधत अिेिोिं टर ैनििं ग वीनर्योज़ देख सिते हैं, तथा वर्ड िे ऑप्शन्स िा 

यूज (Use) िैसे िरिा है यह सीख सिते हैं। 

Microsoft Word Shortcut Keys 

Sr 
No 

Shortcut Key Shortcut Description 

1 Ctrl+A सम्रू्पणड टेक्थट मसलेक्ट करिे के मलए 

2 Ctrl+B मसलेक्ट ककए गए टेक्थट को बोल्ड करिे के मलए 

3 Ctrl+C मसलेक्ट ककए गए टेक्थट को कॉर्पी करिे के मलए 

4 Ctrl+D सेलेक्टेड ऑब्जके्ट को डुस्प्लकेट करिे के मलए या फॉन्ट डायलॉग बॉक्स ओर्पि करिे के 
मलए 

5 Ctrl+E ककसी टेक्थट या रै्पराग्राफ को र्पेज के सेंटर मे करिे के मलए 

6 Ctrl+F कोई टेक्थट या वाक्य खोजिे के मलए 

7 Ctrl+G ककसी वव ेष लाइि र्पर र्पहुचिे के मलए या अन्य भागों र्पर जािे के मलए 

8 Ctrl+H ककसी टेक्थट को ररप्लेस करिे के मलए 

9 Ctrl+I मसलेक्ट ककए गए टेक्थट को नतरछा करिे के मलए 

10 Ctrl+J टेक्थट या रै्पराग्राफ को जथटीफाई करिे के मलए 

11 Ctrl+K सेलेक्टेड टेक्थट र्पर ककसी यूआरएल या फाइल का मलकं लगािे के मलए 

12 Ctrl+L ककसी टेक्थट या रै्पराग्राफ को र्पेज के लेफ्ट मे करिे के मलए 

13 Ctrl+M लाइि या र्पैराग्राफ के मलए इंडेंट को आगे बढािे के मलए 

14 Ctrl+Shift+M लाइि या र्पैराग्राफ के मलए इंडेंट को र्पीछे ले जािे के मलए 

15 Ctrl+N िया डाक्यूमेंट लेिे के मलए 

16 Ctrl+O र्पहले से सेव डाक्यूमेंट को ओर्पि करिे के मलए 

17 Ctrl+P डाक्यूमेंट को वप्रन्ट करिे के मलए 

18 Ctrl+Q इंडेंट को रीसेट करिे के मलए 
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19 Ctrl+R ककसी टेक्थट या रै्पराग्राफ को र्पेज के राइट मे करिे के मलए 

20 Ctrl+S डाक्यूमेंट को सेव करिे के मलए 

21 Ctrl+T लेफ्ट इंडेंट को आगे ले जािे के मलए 

22 Ctrl+Shift+T लेफ्ट इंडेंट को र्पीछे ल ेजािे के मलए 

23 Ctrl+U सेलेक्टेड टेक्थट को अन्डरलाडइि करिे के मलए 

24 Ctrl + Shift + D सेलेक्टेड टेक्थट को डबल अन्डरलाडइि करिे के मलए 

25 Ctrl + Shift + W थर्पेस को छोडकर मसफड   ब्दों को अन्डरलाइि करिे के मलए 

26 Ctrl+V कॉर्पी या कट ककए गए टेक्थट को र्पथेट करिे के मलए 

27 Ctrl+W वतडमाि खुले डाक्यूमेंट को बंद करिे के मलए 

28 Ctrl+X सेलेक्टेड टेक्थट को कट करिे के मलए 

29 Ctrl+Y एक थटेर्प आगे जािे के मलए 

30 Ctrl+Z एक थटेर्प र्पीछे जािे के मलए 

Other Microsoft Word Shortcut Keys 

नीचे कुछ अन्य Microsoft Word Shortcut Keys दी गई हैं जो डाक्यूमेंट की एडडटटिंग, फोमेटटिंग व कन्रोल िंग से सिंबिंधित हैं। 
Sr No Shortcut Keys Shortcut Description 

31 Ctrl+[ फॉन्ट साइज़ बडा करिे के मलए 

32 Ctrl+] फॉन्ट साइज़ छोटा करिे के मलए 

33 Ctrl+Alt+H सेलेक्टेड टेक्थट को हाईलाइट करिे के मलए 

34 Ctrl+Spacebar सेलेक्टेड टेक्थट को डडफॉल्ट फॉन्ट साइज़ मे करिे के मलए 

35 Ctrl + Shift + N सेलेक्टेड टेक्थट या रै्पराग्राफ में िामडल थटाइल अप्लाई करिे के मलए 

36 Ctrl + Shift + + सेलेक्टेड टेक्थट में सुर्परस्थक्रप्ट अप्लाई करिे के मलए 

37 Ctrl + = सेलेक्टेड टेक्थट में सबस्थक्रप्ट अप्लाई करिे के मलए 

38 Ctrl + Shift + C ककसी टेक्थट या रै्पराग्राफ की फॉमेटटगं को कॉर्पी करिे के मलए 

39 Ctrl + Shift + V कॉर्पी की गयी फॉमेटटगं को ककसी अन्य टेक्थट या र्पैराग्राफ में अप्लाई करिे के मलए 

40 Ctrl + Left Arrow कसडर को डॉक्यूमेंट में एक  ब्द बाएं (left) ओर ले जािे के मलए 

41 Ctrl + Right Arrow कसडर को डॉक्यूमेंट में एक  ब्द दायी (right) ओर ले जािे के मलए 

42 Ctrl + Up Arrow कसडर को एक र्पैराग्राफ उप्र्पर ले जािे के मलए 

43 Ctrl + Down Arrow कसडर को एक र्पैराग्राफ निचे ले जािे के मलए 

44 Ctrl + Home कसडर को डॉक्यूमेंट के  ुरुवात में ले जािे के मलए 

45 Ctrl + End कसडर को डॉक्यूमेंट के अंत में ले जािे के मलए 

46 Page Up र्पेज को उप्र्पर की तरफ थक्रॉल करिे के मलए 

47 Page Down र्पेज को निचे की तरफ थक्रॉल करिे के मलए 

48 Shift + F5 डॉक्यूमेंट में वर्पछली तीि र्पोजी ि में कसडर को ले जािे के मलए 

49 Ctrl + F6 अगली वडड डॉक्यूमेंट ववडंो में जािे के मलए। 
50 Ctrl + Shift + F6 वर्पछली वडड डॉक्यूमेंट ववडंो में जािे के मलए। 
51 Ctrl + Del कसडर के दाई ओर स्थित एक  ब्द को डडलीट करिे के मलए 

52 Ctrl + Backspace कसडर के बाई ओर स्थित एक  ब्द को डडलीट करिे के मलए 

53 Ctrl + Shift + L बुलेट मलथट इन्सटड करिे के मलए 

54 Ctrl + Alt + L िंबर मलथट इन्सटड करिे के मलए 

55 Alt + Ctrl + C कॉर्पीराइट मसबंल इन्सटड करिे के मलए 

56 Alt + Ctrl + T टे्रडमाकड  मसबंल इन्सटड करिे के मलए 
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57 Ctrl + Alt + 4 रूर्पए मसबंल इन्सटड करिे के मलए 

58 Ctrl + Alt + M सलेक्टेड टेक्थट में कमेंट इन्सटड करिे के मलए 

59 Alt + Shift + D आज की तारीख जोडिे के मलए 

60 Alt + Shift + T अभी का समय जोडिे के मलए 

61 F4 अंनतम थटेर्प को दोहरािे के मलए 

62 Alt + F4 एम.एस. वडड ववडंो को बंद करिे के मलए 

63 F7 डॉक्यूमेंट में थरे्पमलगं और ग्रामर चेक करिे के मलए 

64 Ctrl + F1 ररबि टदखािे और नछर्पािे के मलए 

65 Alt टैब्स एस्क्टवटे करिे के मलए 

66 Alt + F एमएस वडड में फाइल मेन्यू खोलिे के मलए 

67 Alt + H (Home Tab) होम टैब खोलिे के मलए 

68 Alt + N (Insert Tab) इन्सटड टैब खोलिे के मलए 

69 Alt + G (Design Tab) डडजाइि टैब खोलिे के मलए 

70 Alt + P (Layout Tab) लेआउट टैब खोलिे के मलए 

71 Alt + S (References 
Tab) 

रेफरेंस टैब खोलिे के मलए 

72 Alt + M (Mailings 
Tab) 

मेमलगं टैब खोलिे के मलए 

73 Alt + R (Review Tab) ररव्यु टैब खोलिे के मलए 

74 Alt + W (View Tab) व्यू टैब खोलिे के मलए 

 


